HUMAN COMPUTER INTERACTION (20CS0534) - 2025|

UNIT I
SYSTEM MENUS, WINDOWS, CONTROLS

System menus: Structures of Menus, Functions of Menus, Content of Menus, Kinds of
Graphical menus

Windows: Window characteristics, Components of a window, Window presentation styles,
Types of windows, Window management

Controls: Characteristics of device based controls, Selecting the proper device based controls, Operable

controls, Text Entry/Read-only controls, Selection controls, Combination Entry/selection controls,
Selecting the proper controls

STRUCTURES OF MENUS

» Menus vary in form from very simple to very complex. They may range from small dialog
boxes requesting the user to choose between one of two alternatives, to hierarchical tree
schemes with many branches and level of depth.

A menu’s structure defines the amount of control given to the user in performing a task. The
most common structures are the following.

Single Menus

» In this simplest form of menu, a single screen or window is presented to seek the user’s input or
request an action to be performed, as illustrated in Figure.

Single menus conceptually require choices from this single menu only, and no other menus will
follow necessitating additional user choices.

The user need only consider the immediate consequences of the itembeing chosen and need
not be concerned with any other additional system menus. A single menu may be iterative if it requires

data to be entered into it and this data input is subject to a validity check that fails. The menu will then be

represented to the user with a message requesting reentry of valid data.

O Choice 1

O Choice 2

O Choice 3

Single menu.

Sequential Linear Menus
» Sequential linear menus are presented on a series of screens possessing only one path. The
menu screens are presented in a preset order, and, generally, their objective is for specifying

parameters or for entering data.
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The length of the path may be short, or long, depending upon the nature of the information
being collected.

Sequential path menus have several shortcomings. A long sequence may become tedious as
menu after menu is presented. The user maynot remember an answer to a previous question, a
question important to the currently presented choices.

The user may also want to return to a previous menu to change an answer or look at an answer,
an awkward process that must be allowed.

Finally, the user may, conceptually, want to complete the menus in a different order than which

they are being presented.

MENU 1

O Choice 1

O Choice 2

O Choice 3

Simultaneous Menus

> Instead of being presented on separate screens, all menu options are available simultaneously,
as illustrated in Figure.
The menu may be completed in the order desired by the user, choices being skipped and
returned to later. All alternatives are visible for reminding of choices, comparing choices, and
changing answers. The tedium associated with a long series of sequential menus is greatly
reduced.
Problems with simultaneous menus are that for large collections of menu alternatives screen
clutter can easily occur, and screen paging or scrolling may still be necessary to view all the choices.
Presenting many menu dependencies and relationships on a screen, especially if poorly

indicated, can also be very confusing for a novice user.

DEPARTMENT OF CSE, SIETK




HUMAN COMPUTER INTERACTION (20CS0534) - 2025|

ALTERNATIVE 1 ALTERNATIVE 3

2 Choice 1 2 Choice 1
2 Choice 2 2 Choice 2
2 Choice 3 2 Choice 3

ALTERNATIVE 2 ALTERNATIVE 4

D Choice 1 D Choice 1
2 Choice 2 2 Choice 2
2 Choice 3 2 Choice 3
2 Choice 3 2 Choice 3

Hierarchical Menus

» When many relationships exist between menu alternatives, and some menu options are only
appropriate depending upon a previous menu selection, a hierarchical structure is the best
solution.

A hierarchical structure results in an increasing refinement of choice as menus are stepped
through, for example, from options, to sub options, from categories to subcategories, from
pagesto sections to subsections, and so on.

» A hierarchical structure can best be represented as an inverse tree, leading to more and more
branches as one moves downward through it. Hierarchical structures are characterized by depth
and breadth, depth being the number of choice levels one must traverse to reach the destination,
breadth being the number of alternatives found at each level.

Common examples of hierarchical design today are found in menu bars with their associated
pull-downs, and in Web sites with their navigation links. The order and structure of branching

in a hierarchy is preset and the normal order of flow one-way, top down.

Menu 1

Menu 2 Menu 3 Menu 4

Menu 5 Menu 6 Menu 7 Menu 8 Menu 9 Menu 10 Menu 11

Menu 12 Menu 13 Menu 14

Hierarchical menus.

Connected Menus
» Connected menus are networks of menus all interconnected in some manner. Movement
through a structure of menus is not restricted to a hierarchical tree, but is permitted between

most or all menus in the network.
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From the user’s perspective there is no top-down traversal of the menu system but an almost

unhindered wandering between any two menus of interest.

A connected menu system may be cyclical, with movement permitted in either direction
between menus, or acyclical, with movement permitted in only one direction.

These menus also vary in connectivity, the extent to which menus are linked by multiple paths.
The biggest advantage of a connected menu network is that it gives the user full control over
the navigation flow.

Its disadvantage is its complexity, and its navigation may be daunting for an inexperienced user.

|

Menu 1

I — —

Menu 4 ] Menu 5 1 Menu 6

% |

Menu 7 Menu 8 t Menu 9

Menu 2 T | Menu 3

Connected menus.

Event-Trapping Menus
» Event Trapping menus provide an ever-present background of control over the system’s state
and parameters while the user is working on a foreground task.

Event-trapping menus generally serve one of three functions.

(1) They may immediately change some parameter in the current environment (bold a piece of
text)

(2) They may take the user out of the current environment to perform a function without

leaving the current environment (perform a spell check), or

(3) They may exit the current environment and allow the user to move to a totally new
environment (Exit).

These menus can also change content based upon the system state, or an event, existing at that
moment. A Paste option in a word-processing application, for example, will only function if

there is something in a clipboard to paste.
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FUNCTIONS OF MENUS

» From the user’s perspective, a menu can be used to perform several functions, to navigate to a

new menu, to execute an action or procedure, to display information, or to input data or
parameters.

Navigation to a New Menu

» Each user selection causes another menu in a hierarchical menu tree to be displayed. The
purpose of each selection is to steer the user toward an objective or goal. Selection errors may
lead the user down wrong paths, and cost time and, perhaps, aggravation, but these errors are
nondestructive and usually undoable.

Execute an Action or Procedure

» A user selection directs the computer to implement an action or perform a procedure. The
action may be something like opening or closing a file, copying text, or sending a message.
In some cases execution may only occur after a hierarchical menu tree is navigated. In other
cases actions may be performed as successive hierarchical menus are encountered and
traversed.
Selection errors may or may not have serious consequences, depending upon the nature of the
action. Accidental selection of critical irreversible actions must be prevented in interface
design.

Displaying Information
The main purpose of selecting a menu choice may simply be to display information. The user
may be searching for specific information in a database or browsing the Web.
The user’s focus is primarily on the information desired and less on the selection function.
In many cases, information retrieval may occur only after a hierarchical menu tree is navigated.
The content material and the user’s interests will determine the paths followed.
Users may spend considerable time and effort understanding and processing uncovered
information in order to evaluate subsequently displayed menu choices.
Wrong turns in the process will again cost time and perhaps aggravation, but these errors are
nondestructive and usually undoable.

Data or Parameter Input

» Each selection specifies a piece of input data for the system or provides a parameter value. Data

or values may be input on a single menu or spread over a hierarchy of menus. The user’s focus
is primarily on the information being provided and, again, less on the selection function.

Selection errors can easily be corrected if detected by the system.

DEPARTMENT OF CSE, SIETK




HUMAN COMPUTER INTERACTION (20CS0534) - 2025|

CONTENT OF MENUS
» A menu consists of four elements, its context, its title, its choice descriptions, and its
completion instructions
Menu Context
» A menu’s context provides information to keep the user oriented. This kind of information is
critical in complex or hierarchical menu systems, where loss of position or disorientation can
easily occur.
Feedback is necessary that tells users where they are in a process, what their past choices were,
and possibly how much farther they still have to navigate.
Verbal linkage, spatial linkage, or both may be used to provide navigation feedback.
Verbal linkage involves providing, on the current menu screen, a listing of choices made on
previous menus that have led to this position. It also involves assuring the user that the
displayed menu is the menu desired. Its title should mirror the option selected on the previous
menu, and its content should reflect its title.
Spatial linkage can be accomplished by graphic methods. Each succeeding menu screen can be
displayed overlapping the previous menu screen so a succession of choices can be seen in a
single view. A sense of progress and distance can then be easily ascertained.
Menu Title
» A menu’s title provides the context for the current set of choices. The title must reflect the

choice selected on the previously displayed menu.

Choice Descriptions

» Choice descriptions are the alternatives available to the user. These descriptions can range from
a mnemonic, numeric, or alphabetized listing of choices to single words or phrases to full
sentences or more.

The style chosen will reflect the experience of the user (novice or expert), the nature of the
choices (well-learned alternatives or not), the nature of the selection mechanism (keyboard or
mouse), and the nature of the system (business system application or Web page).

Completion Instructions

» Completion instructions tell users how to indicate their choices. They may include the rationale
for why the user is being asked to make this choice and the impact the choice will have on
subsequent processes.

Explicit instructions may be needed for first time or casual users of a system.

Experienced users will find overly verbose instructions unnecessary.

The needs of all system users, and the nature of the system, must again be considered in
creating this kind of on-screen guidance.
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KINDS OF GRAPHICAL MENUS

» Providing the proper kinds of graphical menus to perform system tasks is also critical to system
success. The best kind of menu to use in each situation depends on several factors.
» The following must be considered:

v The number of items to be presented in the menu.
v How often the menu is used.
v How often the menu contents may change.

Menu Bar

» The highest-level graphical system menu is commonly called the menu bar. A menu bar
consists of a collection of descriptions that serve as headings or titles for a series of actions on
an associated pull-down menu. A menu bar choice by itself should not initiate an action.

Menu bars often consist of a series of textual words. Some products have placed the choices
within buttons.

|File Edit Options Window Help|

Menu bar composed of text.

] | | | | | | Help |

Menu bar composed of buttons.

Each menu bar item is the top level of a hierarchical menu. It will have a pull-down menu
associated with it, detailing the specific actions that may be performed.
Menu bars are used to present application alternatives or choices to the screen user. Each
system provides a default set of menu bar commands (for ex: File, Edit, View, Window, Help).
Display
» All primary windows must have a menu bar.
» All menu bars must have an associated pull-down menu containing at least two choices.
» Do not allow the user to turn off the display of the menu bar.
» Ifall the items in its associated pull-down menu are disabled, then disable the menu bar item.
v" Display the disabled item in a visually subdued manner.
v However, the disabled pull-down menu must always be capable of being pulled down so
that the choices may be seen.
Location
» Position choices horizontally over the entire row at the top of the screen, just below the screen
title.

> A large number of choices may necessitate display over two rows.

File Edit Options Window
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Layout
» Indent the first choice one space from the left margin.
> Leave at least three spaces between each of the succeeding choices (except for Help which will
be right-justified).

» Leave one space between the final choice and the right margin.

xFilmoxEdit  Options  Window

Selection Indication
» Keyboard cursor:
— Use a reverse video, or reverse color, selection cursor to surround the choice.

— Cover the entire choice, including one blank space before and after the choice word.

File Edit Options Window Help

> Pointer:

— Use reverse video, or reverse color, to highlight the selected choice.

Pull-Down Menu
Proper usage:
To initiate frequently used application actions that take place on a wide variety of different
windows.
A small number of items.
Items best represented textually.

Items whose content rarely changes.

Tabs Justification Spacing Left Right Carriage

None
Left
Center
Right

Menu bar pull-down.
Display
» Display all possible alternatives.
» Gray-out or dim items that cannot be chosen due to the current state of an application.
Location

» Position the pull-down directly below the selected menu bar choice.
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Title
>

Must contain a minimum of two choices.

Restrict to no more than 5 to 10 choices, preferably 8 or less.

Not necessary on a pull-down menu. The title will be the name of the menu bar item chosen.

Item Descriptions

>

Use mixed-case, headline-style words to describe choices.

— If the choices can be displayed graphically, for example, as fill-in patterns, shades, or colors,
textual descriptions are not necessary.

Do not:

— ldentify a menu item by the same wording as its menu title.

— Change the meaning of menu items through use of the Shift key.

— Use scrolling in pull-downs.

— Place instructions in pull-downs.

Organization

>
>

Follow standard platform ordering schemes when they exist.

— Place application-specific choices where they fit best.

Place frequent or critical items at the top.

Separate destructive choices from other choices.

Align choices into columns, with:

— Most frequent choices toward the top.

— Related choices grouped together.

— Choices found on more than one pull-down consistently positioned.
Left-align choice descriptions.

Multicolumn menus are not desirable. If necessary, organize top-to-bottom, then left-to-right.

Layout

>

Leave the menu bar choice leading to the pull-down highlighted in the selected manner
(reverse video or reverse color).

Physically, the pull-down menu must be wide enough to accommodate the longest menu item
description and its cascade or accelerator indicator.

Align the first character of the pull-down descriptions under the second character of the
applicable menu bar choice.

Horizontally, separate the pull-down choice descriptions from the pull-down borders by two

spaces on the left side and at least two spaces on the right side.
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— The left-side border will align with the left side of the highlighted menu bar choice.

— The right-side border should extend, at minimum, to the right side of its highlighted menu

bar choice.

Tabs Justification Spacing Left Right Carriage

None
Left
Center
Right

— Pull-downs for choices on the far right side of the menu bar, or long pull-down descriptions,

may require alignment to the left of their menu bar choice to maintain visibility and clarity.

Page Source Destination Margins Name Init-String Other

Space Compression
Attributes
Format

Labels

Groupings File

» Provide groupings of related pull-down choices: New

Open...

Save

— Incorporate a dotted or dashed line between subgroups. Save As...
Print

Blinter Setup...
descriptions. Exit

— Incorporate a solid line between major groupings.

— Left-justify the lines under the first letter of the columnized choice

— Right-justify the lines under the last character of the longest choice description.

— Display the solid line in the same color as the choice descriptions.

Pull-Downs Leading to Another Pull-Down

Font
apacing
dize
Intensity

» If a pull-down choice leads to another pull-down, provide a cascade
indicator as follows:

— Place an arrow or right-pointing triangle after the choice description.

— Align the triangles to the right side of the pull-down.

— Display the triangle in the same color as the choice descriptions.
Pull-Downs Leading to a Window
»  For pull-down choices leading to a window:
— Place an ellipsis (three dots) after the choice description.
— Do not separate the dots from the description by a space.

— Display the ellipsis in the same color as the choice descriptions.
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Keyboard Equivalents and Accelerators

» Provide unique mnemonic codes by which choices may be selected through the typewriter

keyboard.

— Indicate the mnemonic code by underlining the proper character.

Provide key accelerators for choice selection.
— ldentify the keys by their actual key-top engravings.

— Use a plus (+) sign to indicate that two or more keys must be pressed at the same time.

— Enclose the key names within parentheses ().

— Right-align the key names, beginning at least three spaces to Find... (Ctrl+F)

the right of the longest choice description.

— Display the key alternatives in the same color as the choice

descriptions.

Selection Cursor

Find Next {(F3)
Find Previous {(Shift+F3)
Replace... {Ctrl+R)

> Use a reverse video, or reverse color, selection cursor the same color as the

menu bar to surround the choice.

> Create a consistently sized cursor as wide as the pull-down menu.

Cascading Menus

» Proper usage:

— To reduce the number of choices presented together for selection (reduce menu breadth).

— When a menu specifies many alternatives and the alternatives can be grouped in meaningful

related sets on a lower-level menu.

— When a choice leads to a short, fixed list of single-choice properties.

— When there are several fixed sets of related options.
— To simplify a menu.
— Avoid using for frequent, repetitive commands.

File Edit Lists Tools i

0S0 one
On-Line Window Help

Transaction Report

Income and Expense Report
Summary Report

Budget Report

Net Worth Report

Loan Payment Report

Tax Report
Tax Form Report

Investment Reports

a

Account Forms Loans

Account Book Future

Transactions

Transaction Report

Capital Gains Report
Market Value Report
Performance Report
Price History Report

Investment Investment

Summary

Cieates a repot listing purchases. sales. and other investment lransactions

Cascading menu.
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Cascade Indicator

Place an arrow or right-pointing triangle to the right of each menu
Font

Spacing
Size
Intensity

choice description leading to a cascade menu.
Separate the indicator from the choice description by one space.

Display the indicator in the same color as the choice descriptions.

Location
» Position the first choice in the cascading menu Font
immediately to the right of the selected choice. Spacing
> Leave the choice leading to the cascading menu §Tze
highlighted. Intensity

Levels

Do not exceed three menu levels (two cascades).

— Only one cascading menu is preferred.

Not necessary on the cascading menu.
— The title will be the name of the higher-level menu item chosen.
Other Guidelines
» Follow the organization, content, layout, separation, and selection cursor guidelines for the kind

of menu from which the menu cascades.

Pop-up Menus
» Use to present alternatives or choices within the context of the task.

Mow is the titne

Cut
Copy
Paste
Delete

Font...
QuickFormat...
Spell Check...
Hewveal Codes
Bullets...

Pop-up menu.
Display
» Provide a pop-up menu for common, frequent, contextual actions.
— If the pointer is positioned over an object possessing more than one quality (for example,

both text and graphics), at minimum present actions common to all object qualities.
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Items that cannot be chosen due to the current state of an application should not be displayed.

Continue to display a pop-up until:
— Achoice is selected.
— An action outside the pop-up is initiated.
— The user removes the pop-up.

Location

» Position the pop-up:

— Centered and to the right of the object from which it was requested.
— Close enough to the pointer so that the pointer can be easily moved onto the menu.
— But not so close that the pointer is positioned on an item, possibly leading to accidental
selection.
If the pointer is positioned in such a manner that the pop-up would appear off screen or clipped,
position the menu:
— As close as possible to the object, but not covering the object.
— So that it appears fully on the screen.

Restrict the pop-up to no more than 5 to 10 choices, preferably 8 or less.

Not necessary on a pop-up menu.
If included, clearly describe the menu’s purpose.
Locate in a centered position at the top.

Display in uppercase or mixed-case letters.

Separate it from the menu items by a line extending from the left menu border to the right

border.

Tear-off Menus
» A tear-off menu is a pull-down menu that can be positioned anywhere on the screen for
constant referral. As such, it possesses all the characteristics of a pull-down. It may also be
called a pushpin, detachable, or roll-up menu.
> Its purpose is to present alternatives or choices to the screen user that are needed infrequently at

some times and heavily at other times.

Iconic Menus
» Use to remind users of the functions, commands, attributes, or application choices available.
» Create icons that:

— Help enhance recognition and hasten option selection.
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— Are concrete and meaningful.

— Clearly represent choices.

File Manager Print Manager ~ MS-DOS
Prompt

% ,,a‘ A4 %]

Windows Read Me PIF Editor ClhpBaok
Setup Viewer

Iconic menu (from Microsoft Windows).

» Advantages/disadvantages. Pictures help facilitate memory of applications, and their larger
size increases speed of selection. Pictures do, however, consume considerably more screen
space than text, and they are difficult to organize for scanning efficiency. To create meaningful
icons requires special skills and an extended amount of time. Iconic menus should be used to
designate applications or special functions within an application. Icons must be meaningful and

clear. They should help enhance recognition and hasten option selection.

Pie Menus

» Consider using for:
— Mouse-driven selections, with one- or two-level hierarchies, short lists, and choices
conducive to the format.
A pie menu is a circular representation of menu items, as
illustrated in Figure.
Research has found that this style of menu yields higher
performance than the typical vertical array, especially when the

menu tasks are unrelated.

Default Menu Items Pie menu.
» Every system will provide a set of standard menu items. Using the default items will reduce

design time and encourage interface consistency. System learning time will also be reduced.

Microsoft Windows, for example, provides the following standard and optional menu bar items
and pull-down actions.

File

» A standard element, the File menu provides all the commands needed to open, create, and save
files. Some standard File functions are:
v" New
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Open
Close
Save
Save As
Print Preview
Print
Exit
Edit
» A standard element, the Edit menu provides commands that affect the state of selected objects.

Some standard Edit functions are:
Undo
Cut
Copy
Paste
Select All
Find
Replace

View
» An optional element, the View menu provides commands that affect the perspective, details,

and appearance of the application. They affect the view, not the data itself. The view functions

are application-specific and include the following:
Toolbars
Status Bar

Zoom In

Zoom Out

v
v
v' Magnify
v
v
v

Grid Points
Window
» The Window menu, an optional element, provides commands to manipulate entire windows.
Included are items such as:
New Window
Arrange All
Hide
Show
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Help

» The Help menu, a standard element, provides Help commands, including:

v

v
v
v

Contents

Search for Help On
How to Use Help
About (Application)

Menu Proper Usage Summary

Menu Bar To identify and provide access to:
« Common and frequently used application actions.
+ Actions that take place in a wide variety of different windows.

Pull-Down Menu For frequently used application actions that take place in a wide
variety of different windows:
+ A small number of items (5-10).
« ltems rarely changing in content.

Cascading Menu To simplify a higher-level menu.
To provide easier browsing of a higher-level menu.
For mutually exclusive choices.
Restrict to 1-2 cascades.

Pop-Up Menu For:
* Frequent users.
+ Frequently used contextual commands.
+ A small number of items (5-10).
+ ltems rarely changing in content.
+ ltems that require a small amount of screen space.

Tear-Off Menu For items:
+ Sometimes frequently selected.
+ Sometimes infrequently selected.
+ Small in number (5-10).
« Rarely changing in content.

Iconic Menu To designate applications available.
To designate special functions within an application.

WINDOWS

> A

window is an area of the screen, usually rectangular in shape, defined by a border that

contains a particular view of some area of the computer or some portion of a person’s dialog

with the computer.
WINDOW CHARACTERISTICS: A window is seen to possess the following characteristics:

A

name or title, allowing it to be identified.

Assize in height and width (which can vary).

A state, accessible or active, or not accessible.

Visibility—the portion that can be seen.

A

location, relative to the display boundary.
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Presentation, that is, its arrangement in relation to other windows. It may be tiled, overlapping,

or cascading.
Management capabilities, methods for manipulation of the window on the screen.
Its highlight, that is, the part that is selected.
The function, task, or application to which it is dedicated.
The Attraction of Windows
» The value of windowing is best seen in the context of a task or job.
» While all the advantages and disadvantages of windows are still not completely understood,
windows do seem to be useful in the following ways.
Presentation of Different Levels of Information
» Information can be examined in increasing levels of detail. A document table of contents can be
presented in a window. A chapter or topic selected from this window can be simultaneously
displayed in more detail in an adjoining window. Deeper levels are also possible in additional
windows.
Presentation of Multiple Kinds of Information
» Variable information needed to complete a task can be displayed simultaneously in adjacent
windows. An order-processing system window could collect a customer account number in one
window and retrieve the customer’s name and shipping address in another window. A third
window could collect details of the order, after which another window could present factory
availability of and shipping dates for the desired items.

Sequential Presentation of Levels or Kinds of Information

» Steps to accomplish a task can be sequentially presented through windows. Successive

windows are presented until all the required details are collected. Key windows may remain
displayed, but others appear and disappear as necessary. This sequential preparation is

especially useful if the information-collection process leads down various paths.

Access to Different Sources of Information
» Independent sources of information may have to be accessed at the same time. This information
may reside in different host computers, operating systems, applications, files. It may be
presented on the screen alongside the problem, greatly facilitating its solution.
» For instance, a writer may have to refer to several parts of a text being written at the same time.
Combining Multiple Sources of Information
» Text from several documents may have to be reviewed and combined into one. Pertinent
information is selected from one window and copied into another.
Performing More Than One Task
» More than one task can be performed at one time. While waiting for a long, complex procedure
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to finish, another can be performed. Tasks of higher priority can interrupt less important ones.

The interrupted task can then be resumed without the necessity to “close down” and “restart.”
Reminding
» Windows can be used to remind the viewer of things likely to be of use in the near future.
Examples might be menus of choices available, a history of the path followed or the command
choices to that point, or the time of an important meeting.
Monitoring
» Changes, both internal and external, can be monitored. Data in one window can be modified
and its effect on data in another window can be studied.
Multiple Representations of the Same Task
» The same thing can be looked at in several ways—for example, alternate drafts of a speech,
different versions of a screen, or different graphical representations of the same data.
Constraints in Window System Design
» Windowing systems, in spite of their appeal and obvious benefits, have failed to completely live
up to their expectations.
The problems with windowing systems can be attributed to three factors: historical
considerations, hardware limitations, and human limitations.
Historical Considerations
v" There are few concrete window design guidelines to aid designers.
v" This lack of guidelines makes it difficult to develop acceptable and agreeable window
standards.
Standardization of the interface is also inhibited by other factors.
The result is that developers of new systems create another new variation each time they
design a product, and users must cope with a new interface each time they encounter a

new windowing system.

Hardware Limitations

v" Many of today’s screens are not large enough to take full advantage of windowing

capabilities. As a result, many windows are still of “Post-It” dimensions.

v' Either seeing all the contents of one window is preferable to seeing small parts of many
windows or the operational and visual complexity of multiple windows is not wanted.

v" Also, the slower processing speeds and smaller memory sizes of some computers may
inhibit the use of windows.

v A drain on the computer’s resources may limit feedback and animation capabilities,
thereby reducing the system’s usability.

v Poor screen resolution and graphics capability may also deter effective use of windows
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by not permitting sharp and realistic drawings and shapes.

Human Limitations

v A windowing system, because it is more complex, requires the learning and using of
more operations. Much practice is needed to master them.

v" It is also suggested that to be truly effective, window manipulation must occur implicitly
as a result of user task actions, not as a result of explicit window management actions by
the user.

COMPONENTS OF A WINDOW
» A typical window may be composed of so many elements. Some appear on all windows; others
only on certain kinds of windows, or under certain conditions.

Control Panel M [=] B3
Fle Edt View Help

Accessibilty  AddNew  Add/Remove  Date/Time Desktap
: Options : Hardware Programs Themes

% A o &

Display Find Fast Fonts Internet Joystick

Keyboard  Mail and Fax Modems Mouse

% 2 @

M abiamel Dasccmiards Printars Ranianal

22 object|s]

Micaosoft Windows primary window.
Frame
» A window will have a frame or border, usually rectangular in shape, to define its boundaries
and distinguish it from other windows. While a border need not be rectangular, this shape is a
preferred shape for most people. Also, textual materials, which are usually read from left to
right, fit most efficiently within this structure.
Title Bar
» The title bar is the top edge of the window, inside its border and extending its entire width. This
title bar is also referred to by some platforms as the caption, caption bar, or title area.
» The title bar contains a descriptive title identifying the purpose or content of the window.
Title Bar Icon
» Located at the left corner of the title bar in a primary window, this button is used in Windows to

retrieve a pull-down menu of commands that apply to the object in the window.
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» When clicked with the secondary mouse button, the commands applying to the object are

presented. Microsoft suggests that:
v"If the window contains a tool or utility (that is, an application that does not create, load,
and save its own data files), a small version of the application’s icon should be placed
there instead.
If the application creates, loads, and saves documents or data files and the window
represents the view of one of its files, a small version of the icon that represents its
document or data file type should be placed there.
Even if the user has not yet saved the file, display the data file icon rather than the
application icon, and again display the data file icon after the user saves the file.
Window Sizing Buttons
> Located at the right corner of the title bar, these buttons are used to manipulate the size of a
window. The leftmost button, the minimize button— inscribed with a short horizontal line
toward the bottom of the button—is used to reduce a window to its minimum size, usually an
icon. It also hides all associated windows.
The maximize button—typically inscribed with a large box—enlarges a window to its
maximum size, usually the entire screen.
When a screen is maximized, the restore button replaces the maximize button, since the
window can no longer be increased in size. The restore button—typically inscribed with a pair

overlapping boxes—returns a window to the size it had before a minimize or maximize action

was performed. A close button—typically inscribed with an X—closes the window

Sizing buttons are included on primary windows only.
When these buttons are displayed, use the following guidelines:

v When a window does not support a command, do not display its command button.
v The Close button always appears as the rightmost button. Leave a gap between it and
any other buttons.
The Minimize button always precedes the Maximize button.
The Restore button always replaces the Maximize button or the Minimize button when
that command is carried out.
What’s This? Button
» The What’s This? Button, which appears on secondary windows and dialog boxes, is used to
invoke the What’s This? Windows command to provide contextual Help about objects
displayed within a secondary window. When provided, it is located in the upper-right corner of
the title bar, just to the left of the close button.

» On a primary window this command is accessed from the Help drop-down menu.
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What's This? button.

Menu Bar
» A menu bar is used to organize and provide access to actions. It is located horizontally at the
top of the window, just below the title bar. A menu bar contains a list of topics or items that,
when selected, are displayed on a pull-down menu beneath the choice.
Status Bar
> Information of use to the user can be displayed in a designated screen area or areas. They may
be located at the top of the screen in some platforms and called a status area, or at the screen’s
bottom. Microsoft recommends the bottom location and refers to this area as the status bar. It is
also referred to by other platforms as a message area or message bar.
Scroll Bars
» When all display information cannot be presented in a window, the additional information must
be found and made visible. This is accomplished by scrolling the display’s contents through use
of a scroll bar.
» A scroll bar is an elongated rectangular container consisting of a scroll area or shaft, a slider
box or elevator, and arrows or anchors at each end.
For vertical scrolling, the scroll bar is positioned at the far right side of the work area, extending
its entire length.
» Horizontal scrolling is accomplished through a scroll bar located at the bottom of the work area.
Split Box
» A window can be split into two or more pieces or panes by manipulating a split box located
above a vertical scroll bar or to the left of a horizontal scroll bar. A split box is sometimes
referred to as a split bar. A window can be split into two or more separate viewing areas that
are called panes.
» Splitting a window permits multiple views of an object. A split window allows the user to:
v Examine two parts of a document at the same time.
v Display different, yet simultaneous, views of the same information.
Toolbar
» They are sometimes called command bars. Toolbars are designed to provide quick access to
specific commands or options. Specialized toolbars are sometimes referred to as ribbons,

toolboxes, rulers, or palettes.
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Command Area
» In situations where it is useful for a command to be typed into a screen, a command area can be
provided. The desired location of the command area is at the bottom of the window.
» Ifahorizontal scroll bar is included in the window, position the command area just below it.
Size Grip
» A size grip is a Microsoft Windows special handle included in a window to permit it to be
resized. When the grip is dragged the window resizes, following the same conventions as the
sizing border.
Three angled parallel lines in the lower-right corner of a window designate the size grip.
If the window possesses a status bar, the grip is positioned at the bar’s right end.
Otherwise, it is located at the bottom of a vertical scroll bar, the right side of a horizontal scroll
bar, or the junction point of the two bars.
Work Area
» The work area is the portion of the screen where the user performs tasks. It is the open area
inside the window’s border and contains relevant peripheral screen components such as the
menu bar, scroll bars, or message bars.
The work area may consist of an open area for typing, or it may contain controls (such as text
boxes and list boxes) or customized forms (such as spreadsheets).

» The work area may also be referred to as the client area.

WINDOW PRESENTATION STYLES

» The presentation style of a window refers to its spatial relationship to other windows. There are
two basic styles, commonly called tiled or overlapping.
Tiled Windows
» Tiled windows appear in one plane on the screen and
expand or contract to fill up the display surface, as
needed. Most systems provide two-dimensional tiled

windows, adjustable in both height and width.

Overlapping Windows

. . Tiled windows.
» Overlapping windows, may be placed on top of one another like papers on a desk. 1ney possess

a three-dimensional quality, appearing to lie on different planes.
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» Most systems today normally use this style of window. They have the following advantages:

v Visually, their look is three-dimensional, resembling the desktop that is familiar to the user.
Greater control allows the user to organize the windows to meet his or her needs.
Windows can maintain larger sizes.
Windows can maintain consistent sizes.
Windows can maintain consistent positions.
Screen space conservation is not a problem, because windows can be placed on top of one
another.
There is less pressure to close or delete windows no longer needed.
The possibility exists for less visual crowding and complexity. Larger borders can be
maintained around window information, and the window is more clearly set off against its
background. Windows can also be expanded to fill the entire display.
They yield better user performance for tasks where the data requires much window

manipulation to complete the task.

Cascading Windows
> A special type of overlapping window has the windows automatically arranged in a regular

progression.

Cascading windows.

Picking a Presentation Style
» Use tiled windows for:
v" Single-task activities.
v' Data that needs to be seen simultaneously.
v' Tasks requiring little window manipulation.
v Novice or inexperienced users.
» Use overlapping windows for:
v" Switching between tasks.
v' Tasks necessitating a greater amount of window manipulation.
v' Expert or experienced users.
v Unpredictable display contents.
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TYPES OF WINDOWS
» The Microsoft Windows windowing scheme will have the following types of windows:
Primary Window
» Proper usage:
v" Should represent an independent function or application.
v" Use to present constantly used window components and controls.
« Menu bar items that are:

4. My Computer I [=] B4
v" Used frequently. fie Edt View Hep

v Used by most, or all, primary or secondary windows. ﬁ'a’ =) :3}
. 3¥% Floppy [4:) Co-service [C) Psdedwin (D)
« Controls used by dependent windows.
v" Use for presenting information that is continually updated. lﬁ] Q] i|

. Contid P Printere Dig-u
« For example, date and time. RS T oo

v" Use for providing context for dependent windows to be 1 beec(s) selected |

created. Microsoft Windows primary window.
v" Do not:

« Divide an independent function into two or more primary windows.

« Present unrelated functions in one primary window.

Secondary Windows

» Secondary windows are supplemental windows. Secondary windows may be dependent upon a

primary window or displayed independently of the primary window.

I abs [ 7| B
Ilab Stop Bositicr: Defauk Tab Stops:  [0.5" =i oK |

= ~Abgnment [ Leader
i+ Left = 1 None
" Center o
" Right -
" Decimal ’ ~ -
" Bar | 4

| 1
Tab Stope to Be Cleared:

Figure 5.8 Microsoft Windows secondary window.

» A dependent secondary window is one common type. It can only be displayed from a
command on the interface of its primary window. It is typically associated with a single data
object, and appears on top of the active window when requested. It is movable, and scrollable.

» An independent secondary window can be opened independently of a primary window—for

example, a property sheet displayed when the user clicks the Properties command on the menu of a
desktop icon
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» Proper usage:

v" For performing subordinate, supplemental, or ancillary actions that are:
« Extended or more complex in nature.
+ Related to objects in the primary window.

v" For presenting frequently or occasionally used window components.
» Important guidelines:

v" Should typically not appear as an entry on the taskbar.
v Asecondary window should not be larger than 263 dialog units x 263 dialog units.

» A secondary window can be modal or modeless.

Modal:

» Use when interaction with any other window must not be permitted.
» Use for:

v" Presenting information. For example, messages (sometimes called a message box).

v" Receiving user input. For example, data or information (sometimes called a prompt box).
v Asking questions.  For example, data, information, or directions (sometimes called a
question box).
> Use carefully because it constrains what the user can do.
Modeless:
Use when interaction with other windows must be permitted.
Use when interaction with other windows must be repeated.
Access to additional options can be accomplished by inclusion of a command button that opens
another secondary window. These multiple secondary windows needed to complete a task may
be presented in two forms, cascading or expanding.
Cascading:
» Purpose: To provide advanced options at a lower level in a complex dialog.
» Guidelines:
Provide a command button leading to the next dialog box with a “To a Window”
indicator, anellipsis (. . .).
Present the additional dialog box in cascaded form.
Provide no more than two cascades in a given path.
* Do not cover previous critical information.

o Title Bar.
o Relevant displayed information.

« If independent, close the secondary window from which it was opened.
Unfolding:

» Purpose: To provide advanced options at the same level in a complex dialog.
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» Guidelines:

* Provide a command button with an expanding dialog symbol (>>).

« Expand to right or downward.
Dialog Boxes
» Use for presenting brief messages.
» Use for requesting specific, transient actions.
» Use for performing actions that:
— Take a short time to complete.
— Are not frequently changed.
» Command buttons to include:
— OK.
— Cancel.
— Others as necessary.
Property Sheets
» Use for presenting the complete set of properties for an object.
» Categorize and group within property pages, as necessary.
— Use tabbed property pages for grouping peer-related property sets.
— The recommended sizes for property sheets are:
» 252 DLUs wide x 218 DLUs high
« 227 DLUs wide x 215 DLUs high
+ 212 DLUs wide x 188 DLUs high
— Command buttons to include:

« OK. « Cancel.  Apply. * Reset.

« Others as necessary.

— For single property sheets, place the commands on the sheet.

— Fortabbed property pages, place the commands outside the tabbed pages.

Property Inspectors

» Use for displaying only the most common or frequently accessed object properties.
» Make changes dynamically

Message Boxes

» Use for displaying a message about a particular situation or condition.

» Command buttons to include:

— OK., Cancel. Help. Yes and No, Stop.

— Buttons to correct the action that caused the messagebox to be displayed.

> Enable the title bar close box only if the message includes a cancel button.
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> Designate the most frequent or least destructive option as the default command button.

Palette Windows

» Use to present a set of controls. i BN
_ _ 7 2 Q
»> Design as resizable. J & A

— Alternately, design them as fixed in size. T N
O6 %

Pop-up Windows Microsoft Windows palette window.

» Use pop-up windows to display: g;ltli_loﬁe

Move

— Additional information when an abbreviated form of the Sire
information is the main presentation. Abways On Top
— Textual labels for graphical controls. it

-
Microsoft Windows pop-up window.

— Context-sensitive Help information.

WINDOW MANAGEMENT
» Microsoft Windows also provides several window management schemes, a single document
interface, a multiple-document interface, workbooks, and projects.
» To choose the right scheme to present an application’s collection of related tasks or processes,
consider a number of design factors, including: the intended users and their skill level, the

application and its objects or tasks, and the most effective use of display space

Single-Document Interface

» Description:

— Assingle primary window with a set of secondary windows.

» Proper usage:

— Where object and window have a simple, one-to-one relationship.

— Where the object’s primary presentation or use is as a single unit.

— To support alternate views with a control that allows the view to be changed.

— To support simultaneous views by splitting the window into panes.

» Advantages:

— Most common usage.

— Window manipulation is easier and less confusing.

— Data-centered approach.

» Disadvantage:

— Information is displayed or edited in separate windows.
Multiple-Document Interface

»  Description:

— Atechnique for managing a set of windows where documents are opened into windows.
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— Contains:

+ Assingle primary window, called the parent.

+ A set of related document or child windows, each also essentially a primary window.

— Each child window is constrained to appear only within the parent window.

— The child windows share the parent window’s operational elements.

— The parent window’s elements can be dynamically changed to reflect the requirements of the
active child window.

» Proper usage:

— To present multiple occurrences of an object.

— To compare data within two or more windows.

— To present multiple parts of an application.

— Best suited for viewing homogeneous object types.

— To clearly segregate the objects and their windows used in a task.

» Advantages:

— The child windows share the parent window’s interface components (menus, toolbars, and status
bars), making it a very space-efficient interface.

— Useful for managing a set of objects.

— Provides a grouping and focus for a set of activities within the larger environment of the
desktop.

> Disadvantages:

— Reinforces an application as the primary focus.

— Containment for secondary windows within child windows does not exist, obscuring window
relationships and possibly creating confusion.

— Because the parent window does not actually contain objects, context cannot always be
maintained on closing and opening.

— The relationship between files and their windows is abstract, making an MDI application more
challenging for beginning users to learn.

— Confining child windows to the parent window can be inconvenient or inappropriate for some
tasks.

— The nested nature of child windows may make it difficult for the user to distinguish a child
window in a parent window from a primary window that is a peer with the parent window but is

positioned on top.

Workbooks
»  Description:

—A window or task management technique that consists of a set of views organized like a
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tabbed notebook.

— It is based upon the metaphor of a book or notebook.
— Views of objects are presented as sections within the workbook’s primary windows; child
windows do not exist.
— Each section represents a view of data.
— Tabs can be included and used to navigate between sections.
— Otherwise, its characteristics and behavior are similar to those of the multiple document
interfaces with all child windows maximized.
Proper usage:
— To manage a set of views of an object.
— To optimize quick navigation of multiple views.
— For content where the order of the sections is significant.
Advantages:
— Provides a grouping and focus for a set of activities within the larger environment of the
desktop.
— Conserves screen real estate.
— Provides the greater simplicity of the single-document window interface.
— Provides greater simplicity by eliminating child window management.
— Preserves some management capabilities of the multiple-document interface.
> Disadvantage:

— Cannot present simultaneous views.

Projects

» Description:
— Atechnique that consists of a container: a project window holding a set of objects.
— The objects being held within the project window can be opened in primary windows that
are peers with the project window.
— Visual containment of the peer windows within the project window is not necessary.
— Each opened peer window must possess its own menu bar and other interface elements.
— Each opened peer window can have its own entry on the task bar.
— When a project window is closed, all the peer windows of objects also close.
— When the project window is opened, the peer windows of the contained objects are restored

to their former positions.

— Peer windows of a project may be restored without the project window itself being restored.
» Proper usage:
— To manage a set of objects that do not necessarily need to be contained.
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— When child windows are not to be constrained.

Advantages:

— Provides a grouping and focus for a set of activities within the larger environment of the
desktop.

— Preserves some management capabilities of the multiple document interface.

— Provides the greatest flexibility in the placement and arrangement of windows.
Disadvantage:

— Increased complexity due to difficulty in differentiating peer primary windows of the project

from windows of other applications.

CHARACTERISTICS OF DEVICE BASED CONTROLS

» Device-based controls, often called input devices, are the mechanisms through which
peoplecommunicate their desires to the system.

» Several specific tasks are performed using graphical systems.

v To point at an object on the screen.
To select the object or identify it as the focus of attention.
To drag an object across the screen.
To draw something free form on the screen.
To track or follow a moving object.
To orient or position an object.
v To enter or manipulate data or information.

» The various devices vary in how well they can perform these actions. Consider two very
important factors. First, is the mechanism a direct or indirect pointing device? Second, in
terms of direction, distance, and speed, what is the relationship between movement of the
hand- operated device and the corresponding pointer movement on the screen? Does the
pointer movement track control movement exactly or does it not?

Trackball
m Description:
v Aspherical object (ball) that rotates freely in all directions in its socket.
v" Direction and speed is tracked and translated into cursor movement.
Joystick
m Description:
v" Astick or bat-shaped device anchored at the bottom.
v Variable in size, smaller ones being operated by fingers, larger ones requiring the

wholehand.

v Variable in cursor direction movement method, force joysticks respond to
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pressure,movable ones respond to movement.

v Variable in degree of movement allowed, from horizontal-vertical only to continuous.

» Graphic Tablet
m Description:
v' Pressure-, heat-, light-, or light-blockage-sensitive horizontal surfaces that lie on the
desktop or keyboard.
v May be operated with fingers, light pen, or objects like a stylus or pencil.
v" Pointer imitates movements on tablet.
v" Finger may be too large for accuracy with small objects
Touch Screen

m Description:

v" A special surface on the screen sensitive to finger or stylus touch.

Light Pen
m Description:

v" Aspecial surface on a screen sensitive to the touch of a special stylus or pen.

m Description:

v" Automatic speech recognition by the computer.

Mouse
m Description:
v A rectangular or dome-shaped, movable, desktop control containing from one to
threebuttons used to manipulate objects and information on the screen.
v Movement of screen pointer mimics the mouse movement.
Mouse Usage Guidelines
m Provide a “hot zone” around small or thin objects that might require extremely fine
mousepositioning.
m Never use double-clicks or double-drags as the only means of carrying out essential
operations.
m Do not use mouse plus keystroke combinations.
m Do not require a person to point at a moving target.
Keyboard
m Description:
v' Standard typewriter keyboard and cursor movement keys.
m Provide window navigation through use of keyboard keys.
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SELECTING THE PROPER DEVICE-BASED CONTROLS

Guidelines for Selecting the Proper Device-Based Control
m Consider the characteristics of the task.
v" Provide keyboards for tasks involving:
* Heavy text entry and manipulation.
» Movement through structured arrays consisting of a few discrete objects.
v" Provide an alternative pointing device for graphical or drawing tasks. The following are
somesuggested best uses:
« Mouse—pointing, selecting, drawing, and dragging.
« Joystick—selecting and tracking.
» Trackball—pointing, selecting and tracking.
« Touch screen—pointing and selecting.
« Graphic tablet—pointing, selecting, drawing, and dragging.
v" Provide touch screens under the following conditions:
« The opportunity for training is minimal.
* Targets are large, discrete, and spread out.
* Frequency of use is low.
» Desk space is at a premium.
« Little or no text input requirement exists.

m Consider user characteristics and preferences.

v" Provide keyboards for touch typists.

m Consider the characteristics of the environment.

m Consider the characteristics of the hardware.

m Consider the characteristics of the device in relation to the application.
m Provide flexibility.

m Minimize eye and hand movements between devices.

SCREEN BASED CONTROLS:

» Screen-based controls, often simply called controls and sometimes called widgets, are the
elements of a screen that constitute its body. By definition, they are graphic objects that
represent the properties or operations of other objects. A control may:

v" Permit the entry or selection of a particular value.
v" Permit the changing or editing of a particular value.

v' Display only a particular piece of text, value, or graphic.
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v" Cause a command to be performed.
v" Possess a contextual pop-up window.
» Three extremely important principles regarding controls are:
v Acontrol must:  Look the way it works. Work the way it looks.
v Acontrol must be used exactly as its design intended.

v Acontrol must be presented in a standard manner.
OPERABLE CONTROLS

» Operable controls are those that permit the entry, selection, changing, or editing of a particular
value, or cause a command to be performed. Classes include buttons, text entry/read-only,
selection, combination entry/selection, and other specialized controls.

Buttons
m Description:

v A square or rectangular-shaped control with a label inside that indicates action to be
accomplished. The label may consist of text, graphics, or both.

m Purpose:

OK l | Cancel ﬂ | Help l

Command buttons.

v To change properties. EFE =R EE] DL = EElE= 2]

v" To start actions.

v To display a pop-up menu. Toolbar buttors without labels.
m Proper usage: E|
v Use for frequently used actions tha. ... .. aambelbuton, Lo...
« To cause something to happen immediately.
« To display another window.
« To display a menu of options.
* To set a mode or property value.
Command Buttons
Command button guidelines include the following.
Usage
m For windows with a menu bar:
v Use to provide fast access to frequently used or critical commands.
m For windows without a menu bar:
v' Use to provide access to all necessary commands.
Structure
m Provide a rectangular shape with the label inscribed within it.
m Give the button a raised appearance.

m Maintain consistency in style throughout an application.

DEPARTMENT OF CSE, SIETK




HUMAN COMPUTER INTERACTION (20CS0534) |2025

Labels
m Use standard button labels when available.
m Provide meaningful descriptions of the actions that will be performed.
m Use single-word labels whenever possible.
v" Use two-three words for clarity, if necessary.
m Use mixed-case letters with the first letter of each significant label word capitalized.
m Display labels:
v"Inthe regular system font and the same size font.
m Do not number labels.
m Center the label within the button borders, leaving at least two pixels between the text and
thebutton border.
m Provide consistency in button labeling across all screens.
Common button functions should have standard names and uses. Microsoft windows, for example,
provides these standard names and definitions:
OK: Any changed information in the window is accepted and the window is closed.
Cancel: Closes window without implementing unsubmitted changes.
Reset: Resets defaults and cancels any changed information that has not been submitted.
Apply: Any changed information in the window is accepted and again displayed in the window
thatremains open.
Close: Closes the window.
Help: Opens online Help.

Color Palette >>

Provide as large a button as feasible. Cancel

Maintain consistent button heights and widths.

A much too large Color Palette button.

Exception: Buttons containing excessively

longlabels may be wider. Color Palette >>

Number

» Restrict the number of buttons on a window Cancel

tosix or fewer. .
A properly sized Color Palette button.
Toolbars
» Toolbars are compilations of commands, actions, or functions, usually graphical in structure
butsometimes textual, grouped together for speedy access.
» Microsoft Windows defines a toolbar as a panel that contains a set of controls. Toolbars

mayalso be called button bars, control bars, or access bars.
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To provide easy and fast access to most frequently used commands or options across
multiplescreens.
To invoke a sub-application within an application.
To use in place of certain menu items.
Structure
> Images:
v" Provide buttons of equal size.
v" Create a meaningful and unique icon.
+ Design them using icon design guidelines.
v Center the image within the button.
v" Give the button a raised appearance.
v" Ensure that toolbar images are discernible from Web page graphical images.
» Text:
v" Create a meaningful label, adhering to label guidelines for command buttons.
v" Create toolbar buttons of equal size, following the size guidelines recently described.
» Consistency:

v" Use the same icon throughout an application and between applications.

TEXT ENTRY/READ-ONLY CONTROLS
> A Text Entry/Read-Only control contains text that is exclusively entered or modified through
the keyboard. It may also contain entered text being presented for reading or display
purposes only.
Text Boxes
» Description:
v Acontrol, usually rectangular in shape, in which:
* Text may be entered or edited.
* Text may be displayed for read-only purposes.
v Usually possesses a caption describing the kind of information contained within it.
v Anoutline field border:
* Isincluded for enterable/editable text boxes.
« Is not included for read-only text boxes.
v Two types exist:
« Single line.
 Multiple line.
v When first displayed, the box may be blank or contain an initial value.
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» Purpose:
v To permit the display, entering, or editing of textual information.
v To display read-only information.
» Proper usage:
v Most useful for data that is:
« Unlimited in scope.
« Difficult to categorize.
« Of a variety of different lengths.
v When using a selection list is not possible.
Single-Line and Multiple-Line Text Boxes
> Single line:
v" Description:
« A control consisting of no more than one line of text.
v" Purpose:
« To make textual entries when the information can be contained within one line of
thescreen.
v Typical uses:
« Typing the name of a file to save.
» Typing the path of a file to copy.
« Typing variable data on a form.
* Typing a command.
Multiple line:

v" Description: A control consisting of a multiline rectangular box for multiple lines of text.

Entry/Modification:

Display/Read Only: Information

v" Purpose:
* To type, edit, and read passages of text.
Typical uses:

» Creating or reading an electronic mail message. Text boxes.

» Displaying and editing text files.

SELECTION CONTROLS
» A selection control presents on the screen all the possible alternatives, conditions, or choices
that may exist for an entity, property, or value. The relevant item or items are selected from
those displayed.
» Selection controls include radio buttons, check boxes, list boxes, drop-down/pop-up list

boxes, and palettes.
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Radio Buttons
> Description:

v A two-part control consisting of the following:

« Small circles, diamonds, or rectangles.

« Choice descriptions.

v When a choice is selected:
« The option is highlighted.
+ Any existing choice is automaticall
unhighlighted and deselected.
» Purpose:
v" To set one item from a small set of

O Monthly
® Quarterly

() Semi-annually Semi-annually

O Annually

Monthly
Quarterly

Annually

Radio buttons.

mutually exclusive options (2 to 8).

Check Boxes
» Description:

v Atwo-part control consisting of a square box and choice description.

v" Each option acts as a switch and can be either “on” or “off.”

~Alignment———
(F Lght

(" Center

" Right

" Decinal

C Bar

L |

Radio buttons.

» When an option is selected (on), a mark such as an “X” or “check” appears within the

squarebox, or the box is highlighted in some other manner.

« Otherwise the square box is unselected or empty (off).

v Each box can be:
« Switched on or off independently.
+ Used alone or grouped in sets.

Purpose:

v To set one or more options as either on or off.

Proper usage:

v" For setting attributes, properties, or values.

X Bold
O ralic
[J Subscript
Underline

Chedk boxes.

For nonexclusive choices (that is, more than one can be selected).

v
v Where adequate screen space is available.
v

Most useful for data and choices that are:

« Discrete.
« Small and fixed in number.

* Not easily remembered.

* In need of a textual description to describe meaningfully.

Underline

» Most easily understood when the alternatives can be seen together and comparedto
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oneanother.
* Never changed in content.
v" Can be used to affect other controls.
v" Use only when both states of a choice are clearly opposite and unambiguous.
Palettes
» Description:
v A control consisting of a series of graphical alternatives. The
choices themselves are descriptive, being composed of colors,

patterns, or images.

v" In addition to being a standard screen control, a palette may | [ I I O 1 I [

also be presented on a pull-down or pop-up menu or a toolbar. palette.

» Purpose: To set one of a series of mutually exclusive options presented graphically or
pictorially.

Graphical Representations
» Provide meaningful, accurate, and clear illustrations or representations of choices.
» Create images large enough to:
v" Clearly illustrate the available alternatives.
v" Permit ease in pointing and selecting.
» Create images of equal size.

> Always test illustrations before implementing them.

List Boxes
» Description:
v A permanently displayed box-shaped control containing a list of attributes or objects
fromwhich:
« A single selection is made (mutually exclusive), or
 Multiple selections are made (non-mutually-exclusive).
The choice may be text, pictorial representations, or graphics.
Selections are made by using a mouse to point and click.
Capable of being scrolled to view large lists of choices.
No text entry field exists in which to type text.
A list box may be may be associated with a summary list box control, which allows

theselected choice to be displayed or an item added to the list.
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Events: Files:

Aste <none>

Chat Incoming Ring chimes.wavy
Chat Outgoing Ring oId

Critical Stop cointabl.wav
Default Beep ding.wav

E xclamation kerchunk.wav
Money Transaction Entry rngin.way

Question #| |ringout.way

List boxes.
» Purpose:
v" Todisplay a collection of items containing:
 Mutually exclusive options.

 Non-mutually-exclusive options.
Single-Selection List Boxes

» Purpose:
v To permit selection of only one item from a large listing.
> Design guidelines:
v Related text box
« If presented with an associated text box control:
Position the list box below and as close as possible to the text box.

The list box caption should be worded similarly to the text box caption.

Destination: [ I

Destination: | Australia Li
Canada
England
France
Germany
New Zealand
Netherlands

If the related text box and the list box are very close in proximity, the caption may beomitted from
the list box.

v" Use the same background color for the text box as is used in the list box.

Australia

+

Canada
England
France
Germany
New Zealand
Netherlands
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Drop-down/Pop-up List Boxes
» Description
v" Asingle rectangular control that shows one item with a small button to the right side.
« The button provides a visual cue that an associated selection box is available but hidden.
When the button is selected, a larger associated box appears, containing a list of choices
fromwhich one may be selected.
Selections are made by using the mouse to point and click.

Text may not be typed into the control.

Country: Canada [French]

Country: orited States |3 Canada (Engiizh
Language: anaada e
Language: English (American| b4 Denmark
enguss [Enaness ! L2 Finland
Lﬂ Keyboard Layout: |France
= Germany

- - Iceland
Measurement: IEngllsh L%I Measurement: Ireland o

Keyboard Layout: I us

Drop-down list boxes. There are four unopened boxes,

Country, Language, Keyboard Layout, and Measurement. Bropdown listbexopend for Country.

Purpose:

To select one item froma large list of mutually exclusive options when screen space is limited.
Advantages:

Requires an extra action to display the list of choices.

When displayed, all choices may not always be visible, requiring scrolling.

The list may be ordered in an unpredictable way, making it hard to find items.

Proper usage:

For selecting values or setting attributes.

For choices that are mutually exclusive (only one can be selected).

Where screen space is limited.

>
v
>
v
v
v
>
v
v
v
v

For data and choices that are:
* Best represented textually.
« Infrequently selected.
* Not well known, easily learned, or remembered.
* Ordered in a unpredictable fashion.
« Large in number.
* Variable or fixed in list length.
v" Use drop-down/pop-up lists when:
« Screen space or layout considerations make radio buttons or single-selection list
boxesimpractical.

* The first, or displayed, item will be selected most of the time.
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v Do not use a drop-down list if it important that all options be seen together.
COMBINATION ENTRY/SELECTION CONTROLS

» It is possible for a control to possess the characteristics of both a text field and a selection

field. In this type of control, information may either be keyed into the field or selected and
placed within it. The types of combination entry/selection fields are spin boxes, attached
combination boxes, and drop-down/pop-up combination boxes.
Spin Boxes
» Description:
v Asingle-line field followed by two small, vertically arranged buttons.

* The top button has an arrow pointing up.

* The bottom button has an arrow pointing down. Left Margin Adjustment: |0 Ig
Selection/entry is made by: Hight Margin Adjustment:  [0" @

« Using the mouse to point at one of the directional Selinioes
buttons and clicking. Items will change by one unit or
step with each click.
» Keying a value directly into the field itself.
Purpose:
To make a selection by either scrolling through a small set of meaningful predefined choices
or typing text.
Boxes
Description:
v Asingle rectangular text box entry field, beneath which is a larger rectangular list box
(resembling a drop-down list box) displaying a list of options.
The text box permits a choice to be keyed within it.
The larger box contains a list of mutually exclusive choices from which one may be
selected for placement in the entry field.

« Selections are made by using a mouse to point and click.  Font Style:
Regular

As text is typed into the text box, the list scrolls to

Italic
Bold
Bold Italic

thenearest match.

When an item in the list box is selected, it is placed into

thetext box, replacing the existing content.
) ) Combo boxes.
Information keyed may not necessarily have to match
thelist items.
Purpose:

v To allow either typed entry in a text box or selection from a list of options in a
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permanentlydisplayed list box attached to the text box.

Drop-down/Pop-up Combo Boxes
» Description:

v" Assingle rectangular text box with a small button to the side and an associated hidden list
ofoptions.
« The button provides a visual cue that an associated selection box is available but hidden.
When requested, a larger associated rectangular box appears, containing a scrollable list
ofchoices from which one is selected.
Selections are made by using the mouse to point and click.
Information may also be keyed into the field.
As text is typed into the text box, the list scrolls to the nearest match.
When an item in the list box is selected, it is placed into the text box, replacing the
existingcontent.

v The information keyed does not necessarily have to match list items.

v Combines the capabilities of both a text box and a drop-down/pop-up list box.

Purpose:

v To allow either typed entry or selection from a list of options in a list box that may

beclosed and retrieved as needed.

SELECTING THE PROPER CONTROLS

» Providing the proper control, or mix of controls, is critical to a system’s success. The proper
control will enable a person to make needed selections, entries, and changes quickly,
efficiently, and with fewer mistakes.

> Improper selection most often leads to the opposite result.

Entry versus Selection—A Comparison
Choosing a Type of Control

» For familiar, meaningful data choose the technique that, in theory, requires the fewest
numberof keystrokes to complete.

» Ifthe data is unfamiliar or prone to typing errors, choose a selection technique.

Aided versus Unaided Entry
» Provide aided entry whenever possible.

v Absorb any extra and unnecessary keystrokes.
v" Provide an auditory signal that auto completion has been performed.

Comparison of GUI Controls
» Direct Manipulation.
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1. Drag and drop on.

2. Drag and drop between.
Selection.

3. Icons.

4. Radio buttons.

5. Menus (drop-down list boxes).
Entry.

6. One entry area.

7. Four entry areas.
Control Selection Criteria

» Selection of the proper control, then, depends on several factors. The first is the structure and

characteristics of the property or data itself. Other considerations include the nature of the
task, the nature of the user, and the limitations of the display screen itself.

Property or data considerations reflect the characteristics of the data itself. Some kinds of
controls are very restrictive in that they permit only specific kinds of information with

specific qualities to be presented within them.

Other kinds of controls may not be as restrictive concerning a data’s qualities, but they are

not well suited to the kind of data being used.

DEPARTMENT OF CSE, SIETK




